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S. BAMJI LAB 
Our Guide to Basic Lab Technique & Rationale 

Synapses of the central nervous system are highly specialized regions of cell-cell 

contact designed to rapidly and efficiently relay signals from one neuron to 

another. By establishing a dynamic yet precise network of synaptic connections, 

the brain is able to attain a level of functional complexity that enables not only 

simple motor tasks, but also sophisticated emotional and cognitive behaviour.  

The study of how synapses form and function is therefore essential to our 

ultimate understanding of higher brain functions such as learning and memory. 


!
Synapses of the CNS are continuously formed, remodeled and eliminated over 

the life of an organism. It has been suggested that perturbation of these 

processes may contribute to the etiology of neurodegenerative diseases such as 

Alzheimer’s, Parkinson’s and Huntington’s disease, as well as developmental and 

psychiatric diseases including autism and schizophrenia.


!
- Shernaz Bamji 

www.bamjilab.com 
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Welcome to the lab!
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Where do we get our neurons? 
!
Embryonic day 18 (E18) Sprague-Dawley rats are extracted from 

pregnant dams. Their embryonic brains are then collected and the 

hippocampus is dissected out. Hippocampal E18 neurons are then 

disaggregated and plated sparsely onto circular glass coverslips 

forming what is known as a primary culture. These coverslips are then 

placed into the wells of a plate and given nutrient media to sustain the 

cells, before being moved to an incubator to regulate temperature and 

CO2 levels. These in vitro primary cultures of hippocampal neurons 

could be used for a variety of purposes, but in the Bamji lab, our 

primary focus is on synapses. 


What is a synapse? 
!
Synapses of the central nervous system are highly specialised regions 

of cell-cell contact designed to rapidly and efficiently relay signals from 

one neuron to another. By establishing a dynamic yet precise network 

of synaptic connections, the brain is able to attain a level of 

functional complexity that enables not only simple motor tasks, but 

also sophisticated emotional and cognitive behaviour.   The study of 

how synapses form and function is therefore essential to our ultimate 

understanding of higher brain functions, such as learning and memory.


!

What is a transfection? 
!
Transfection is a process by which particular nucleic acids are 

introduced to cells in the form of a plasmid. This technique enables 

researchers to selectively introduce the expression of a gene and 

therefore its associated protein. One may wish to perform a DNA/RNA 

transfection for a range of reasons, including the visualisation of cell 

morphology (e.g. a green fluorescent protein or GFP cell fill), the 

fluorescent tagging of a protein (e.g. PSD-95-GFP) and the cellular 

consequences of overexpression of a particular protein. In some 

instances, the transfection may involve the use of short RNAs that 

prevent the cell from expressing a certain protein, then referred to as a 

knockdown experiment. 
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Pictures on the right give an indication of the steps involved. Images of an adult 

Sprague-Dawley rat, an adult rat brain, x-gal staining of the hippocampal region of an 

adult rat brain, the morphology of suspended neurons at 1 day in vitro (DIV), a 

coverslip with a 12-well plate and the morphology of hippocampal neurons cultured 

on a coverslip at >20DIV are shown, respectively. 
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Why might we perform a transfection? 
!
Let’s say protein X is known to be expressed in neurons and decreases in its expression 

have been reported in the post-mortem brains of autism patients compared to healthy 

controls. However, the localisation of this protein within neurons and the trafficking of 

this protein remains unknown. One way to approach this problem is to fluorescently tag 

the protein of interest (e.g. X-BFP) in our transfection plasmid, meaning that our 

introduced nucleic acid produces a protein that contains both our molecule of interest 

(X) and a region that emits light when stimulated at a given wavelength (e.g. BFP). Then, 

using a fluorescence imaging technique known as confocal microscopy, images can be 

taken of these transfected neurons. When our introduced X-BFP protein is present, the 

BFP region shall emit a small amount of light that can be detected by the imaging 

software. However, just visualising the presence of our transfected protein tells us little 

about the localisation of that protein within the neuron. To do that, we first need to 

simultaneously visualise the cell morphology. In order to achieve this, we co-transfect a 

fluorescent protein expressed at high levels capable of filling the entire cell body. It is 

important to remember that this protein must fluoresce at a different light wavelength, 

such that two separate images can be taken of the same cell: one showing the X-BFP 

protein and the other displaying the cell morphology. In the Bamji lab, we are primarily 

concerned with molecules present at synapses either basally or as a result of 

recruitment. However, synapses are difficult to establish or categorise from cell 

morphology alone. Instead, we commonly transfect fluorescently-tagged synaptic 

proteins, such as PSD95. PSD95 is present on the post-synaptic region of the synapse 

and thus indicates incoming connections to the neuron being imaged. Again, if we 

fluorescently tag our synaptic protein (e.g. PSD95-RFP), the tag must fluoresce at a 

different wavelength to the cell fill and our X protein. If our protein of interest co-localises 

(overlaps) with a synaptic protein, we can assume our protein is therefore present at a 

synapse. This imaging can be performed in both fixed or live cells. In the latter case, the 

trafficking of a given protein to and/or from the synapse can be observed over time, 

under different conditions or both. 
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How do I perform a transfection? 
!
1. Prior to transfection, calculate the desired concentrations for your constructs. 

Frequently used constructs in the lab will have an established weight known to work 

well (e.g. 0.5µg for GFP). Be sure to check with fellow lab members, but if you’re 

using a newly acquired construct, 0.5-2µg is the normal range of individual construct 

weights used in the lab. Occasionally, you will have to compare coverslips 

transfected with different constructs. Even though the constructs may differ, you 

must ensure that the total plasmid weight being applied to each coverslip overall is 

the same. If the weight of your test constructs cannot be altered to match across 

your conditions, you will need to use an empty vector such as pDisplay. Each 

construct preparation will also differ in concentration, so be sure to check your 

aliquot every time for the µg/µl. An example of how to perform this calculation and 

write it in your lab book is displayed below;


2. Next, locate your plate in the incubator. At any given time, three weeks of plates are 

present in the incubator. The dates on the inner door correspond to the date the 

cells were plated. Transfection should usually occur at day in vitro (DIV) 11 and thus 

the plates you are transfecting should have a date 10 days prior to the day of 

transfection;


3. Take your plate out of the incubator and check your coverslips under the light 

microscope. Some of them may contain fasciculated neurons or have only sparse 

coverage. If you must use them, try to spread them out across your conditions as 

!4

Pictures to the left show the kind of images produced by fluorescent transfection and confocal microscopy 

post-processing to remove the cell body and axon. Displayed is a composite image of the three pictures, a 

GFP image of cell morphology, a PSD95-RFP image of postsynaptic regions and an X-BFP image of our protein 

of interest. These three proteins are suitable for co-transfection as BFP fluoresces under the 405nm laser, GFP 

under the 488nm laser and RFP under the 543nm laser. The schematic to the right outlines the lipofectamine 

transfection process and broadly how it leads from nucleic acid plasmids to transcription.
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they may not produce the best images. Be sure to label which coverslips fall into 

each condition on the lid of your plate. Try to keep this step fast as the cells dislike 

being out of the incubator and once complete, place your plates back into the 

incubator;


4. Fill two aliquots with 25µl of Opti-MEM media for every coverslip of neurons being 

transfected;


5. Again, for every coverslip, add the DNA plasmids you are transfecting at the relevant 

concentrations for the corresponding coverslip to one of the two aliquots;


6. To the second aliquot for each coverslip, add 1µl of lipofectamine and allow it to sit 

for 5 minutes. Lipofectamine produces complexes and allows your DNA constructs 

to enter the cell;


7. Pipette the lipofectamine aliquot into the DNA aliquot and mix thoroughly for every 

coverslip. Once complete, allow the mixtures to sit for 20 minutes before 

proceeding;


8. Add your mixtures drop wise to their corresponding coverslip and place your plate 

back in the incubator on the top transfected shelf.


What is immunocytochemistry? 
!
Immunocytochemistry (colloquially referred to as ‘immunos’) is the staining or labelling 

of proteins in cell cultures using antibodies. In the Bamji lab, we most frequently use 

fluorescent immunocytochemistry. In this technique, a primary (1°) antibody is targeted 

against a protein of interest within our neurons, e.g. the aforementioned PSD95 present 

post-synaptically. A secondary (2°) antibody is then targeted against the primary 

antibody, creating a complex. However, this secondary antibody is tagged with a 

fluorescent molecule (or conjugated fluorophore) such that imaging the fluorescence of 

this antibody provides a rough estimate of the location of the protein of interest. In the 

below figure, a primary antibody is shown targeting a particular region of the X protein 

and a secondary antibody in turn is targeting the primary antibody. To enable this kind of 

binding, the first antibody is produced by exposing an animal (e.g. a rabbit) to the 
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(1) All of the constructs being transfected in the number of coverslips!
—> Construct name (desired weight) from aliquot concentration: desired weight divided 
by aliquot concentration = volume of construct preparation required per coverslip!
—> Second construct…and so on.!
!
For example:!
(1) GFP + PSD95-RFP + X-BFP in 10 coverslips!
—> GFP (0.5µg) from 1.15µg/µl: 0.5/1.15 = 0.43µl per coverslip!
—> PSD95-RFP (1µg) from 2.15µg/µl: 1/2.15 = 0.47µl per coverslip!
—> X-BFP (1µg) from 1.6µg/µl: 1/1.6 = 0.63µl per coverslip

Model lab book entry for your construct calculations, which should be written in preparation.
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protein of interest intravenously. Eventually, certain animals will develop antibodies 

against a particular epitope or region present on your protein of interest, as it’s perceived 

by the host immune system as non-self. These antibodies can then be purified from the 

animal serum or manufactured by culturing extracted B-cells. Polyclonal antibodies 

capable of binding to several epitopes present on your protein are extracted from animal 

serum, while monoclonal antibodies that bind to a single protein epitope typically arise 

from cultured B cell-myeloma hybridoma lines. The secondary antibody, however, is 

slightly different. It targets the conserved portion of all antibodies from a certain animal 

(e.g. a rabbit) and is thus nonspecific. As you can then imagine, if you need to 

immunostain for several proteins, it is essential to use primary antibodies from different 

animals, so that each secondary antibody is only targeting one primary antibody. 

However, all secondary antibodies must be raised in goats, as we use goat serum to 

prevent nonspecific binding of the secondary fluorescent antibodies (and thus false 

positives in our immunostain). As with transfections, 

when fluorescently immunostaining for several 

proteins simultaneously, secondary antibodies 

that fluoresce at different wavelengths must be 

used, such that each wavelength represents only 

a single type of protein. The excitation 

wavelength of a secondary antibody is typically 

represented in its name, e.g. Alexa Fluor 633 

which has an optimal excitation wavelength of 

633nm. We often perform immunocytochemistry 

in conjunction with transfection.


!

Why might we use immunocytochemistry? 
!
Immunocytochemistry is primarily concerned with visualising proteins in our neurons  

under various conditions. Transfections introduce nucleic acids that are not endogenous 

to our neurons, creating a range of considerations. These include an increase in 

intracellular protein concentrations, unknown cellular effects and atypical treatment of 

the exogenous protein by the cell, among others. Further, a tagged protein (e.g. PSD95-

RFP) may have a different biochemistry to endogenous, untagged proteins (e.g. PSD95) 

due to alterat ions in protein folding or interact ions. In many cases, 

immunocytochemistry is therefore the preferred method for looking at endogenous 

trafficking or expression of proteins in fixed cells. However, it relies on the existence of a 

specific antibody for your protein of interest, which may not exist, and it cannot be 

performed in live cells. Should you wish to visualise proteins in live neurons or you lack 

an antibody for your protein of interest, the transfection of a tagged (e.g. fluorescent) 

protein is the preferred method. Transfection can also be used to indirectly enable 

immunocytochemistry. For example, fluorescent tags are often large molecules, 

increasing the likelihood of upsetting protein biochemistries. By utilising both 
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techniques, a plasmid can be designed to express a protein with a small, non-

fluorescent tag (e.g. the human influenza hemagglutinin or HA tag of PSD95-HA), which 

can then be transfected and immunocytochemistry targeting this small tag can be 

performed. Certain experiments seek to observe the cellular effects of over-expressing a 

particular protein. For these experiments, an antibody may exist for your protein of 

interest, but you will still want to increase protein expression through transfection. These 

two techniques therefore have a range of applications and their use will depend upon 

the intention of the study at hand and the availability of relevant antibodies/plasmids. 


How do I perform immunocytochemistry? 
 

Before starting your immunocytochemistry procedure, you shall want to make sure 

that you have first:


Performed your antibody calculations — for every large coverslip, you require 120µl of 

1% goat serum. Check the dilution of your different antibodies; for example, one 

antibody may be 1:500, while the other is 1:200. This refers to their dilution in 120µl of 

goat serum. So, for a 1:500 antibody, 120µl/500 = 0.24µl of antibody per coverslip. 
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1 = Eppendorf tubes!

2 = 1X PBS!

3 = 0.1% Triton-X in 1X PBS!

4 = Microscope slides!

5 = Tube rack!

6 = 10% goat serum in a 15ml Falcon tube!

7 = 1% goat serum in a 15ml Falcon tube!

8 = 1-200µl pipette tips!

9 = 100-1,250µl pipette tips!

10 = 0.1-10µl pipette tips!

11 = twelve-well plate!

12 = 2-20µl pipette (P20) 

13 = 100-1,000µl pipette (P1000)!

14 = 0.2-2µl pipette (P2)!

15 = 20-200µl pipette (P200)!

16 = Fine forceps!

17 = ProLong!

18 = Aspirator!

19 = Suction tube of aspirator!

20 = Kimwipes tissue!

21 = Timer!

22 = Dark box!

23 = Condensed immunocytochemistry protocol

Left: A picture of the immuno bench in the Bamji lab. As it can appear a little daunting, the schematic shown 

on the right in the above figure highlights the key elements. 
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The recommended format for your lab book is displayed below. In order to find the 

dilution factor, you can consult the Bamji lab antibody list or ask a fellow lab member;


Pre-warmed enough 4% PFA/4% sucrose solution and goat serum — use the 37°c 

water bath in the lab for ~20 minutes. This step is important as both of these solutions 

are kept in the freezer and cold solutions can shock the cells, leading to undesirable 

neurons later when imaging your coverslips. Even if you do not use all of the PFA/

sucrose or goat serum preparations that you thaw, please discard the excess as it 

cannot be reused. As such, be sure to warm just what you need: one tube of 4% PFA/

4% sucrose and one aliquot of goat serum is enough for 18 large coverslips;


Diluted your goat serum — every aliquot of goat serum is ~1ml. You will need to make 

two dilutions in 1X PBS: 10% and 1%. Take two of the skinny 15ml Falcon tubes and 

label them correspondingly with their composition (goat serum in PBS), their dilution 

factor (1%, 10%, etc.), the date and your name. For every coverslip, you require 500µl 

of 10% goat serum and 240µl of 1% goat serum. Always make 100-200µl more than 

the total required to make pipetting a little easier and to avoid transferring bubbles. 

Once complete, place your goat serum dilutions back into the 37°c water bath until 

you’re ready to use them.


Once you’ve finished your preparations, you’re ready to begin: 

!
1. Aspirate all of the maintenance media from every well;


2. Using a P1000 pipette, add 4% PFA/4% sucrose solution to each of your wells 

(0.5ml/well). Remember to pipette slowly so that it trickles down the side of the well 

and is not ejected directly onto the coverslip. This solution fixes your cells, thus 

!8

Blocking 1°ABs Animal 2°ABs Animal

10% goat serum PSD95 Rabbit anti-rabbit-633 Goat

0.5ml/coverslip VGAT Guinea Pig anti-gp-568 Goat

1°ABs Concentration Per coverslip No. of coverslips Total

PSD95 1:200 0.6µl 10 6µl

VGAT 1:500 0.24µl 10 2.4µl

Goat serum 1% 120µl 10 1,200µl

2°ABs Concentration Per coverslip No. of coverslips Total

anti-rabbit-633 1:500 0.24µl 10 2.4µl

anti-gp-568 1:500 0.24µl 10 2.4µl

Goat serum 1% 120µl 10 1,200µl

Model lab book entry for your antibody calculations, which should be written in preparation.
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preserving the present state of the neurons by halting ongoing biochemical reactions 

and increasing the stability of cellular structures;


3. Using a lab timer, incubate the cells for exactly 10 minutes at room temperature in a 

dark box;


4. Aspirate the PFA/sucrose mixture and then wash the coverslips with 1X PBS at 1ml/

well (or mount them if you are not immunostaining and are just fixing). Remember to 

pipette your wash slowly and to the side of the well;


5. Aspirate your 1X PBS wash and then add 0.1% Triton-X (in PBS) at 0.5ml/well to 

permeabilise cellular membranes. This step allows the antibodies you later apply to 

enter the cell and target intracellular proteins or protein regions;


6. Incubate for exactly 10 minutes at room temperature in a dark box;


7. Slowly aspirate the 0.1% Triton-X solution and then wash your coverslips with 1X 

PBS at 1ml/well;


8. Aspirate your 1X PBS wash and then add 0.5ml of 10% goat serum (in PBS) to each 

well. This step prevents non-specific binding of your antibodies;


9. Cover your plate and incubate for 1 hour in a dark box at room temperature. In the 

meantime, ~10 minutes before finishing, make up your previously calculated 1°AB 

solution(s) in Eppendorf tubes and place on ice. Each Eppendorf tube can hold 

enough antibody solution for 10 coverslips, so consider this when doing your 

calculations. When removed from the fridge, antibodies should be placed on ice as 

quickly as possible. Ice can be collected from a room down the hall and should be 

placed into one of the red tubs or in a styrofoam box;


10. Cover the plate lid in a 3 square high, 2 square wide piece of Parafilm. Using fine 

forceps, remove your coverslips from their wells and place them on the Parafilm 

above the well from which they came. Once complete, put your lid with your 

coverslips back on top of the plate. As quickly as possible, to prevent your coverslip 

from drying out, add 111µl of your primary antibody solution(s) to the corresponding 

coverslips;


11. Make a humidity chamber to prevent evaporation by dampening some tissue and 

placing it at the bottom of a plastic container. Put your plate inside this humidity 

chamber, put the lid on and leave it overnight in the 4°c cold room. 


!
The following day, you are ready to: 

!
12. Aspirate the 10% goat serum from the wells and add 1ml of 1X PBS into each well 

before using fine forceps to place your coverslips back into their corresponding 

wells;


13. Aspirate and wash the coverslips three times with 1ml/well of 1X PBS to rid your 

coverslips of excess, unbound antibody. Leave 10 minutes between each wash and 

be sure to store your plates in a dark box during this time - washing is critical! 

Remember to pipette slowly and trickling down the side of the well. In the meantime, 

make up your 2°AB solution(s) in an Eppendorf tube on ice;


!9
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14. Cover your plate lid with the same amount of Parafilm as before, remove your 

coverslips and place them above their corresponding wells. This time, add 111µl of 

your secondary antibody solution(s) to the appropriate coverslips;


15. Incubate your cells for 1 hour at room temperature in a humidity chamber. At this 

stage, be sure to incubate your humidity chamber in the dark as your secondary 

antibodies are fluorescent and therefore affected by the bright lab lights;


16. Again, wash your coverslips three times with 1ml of 1X PBS (storing plates in the 

dark for 10 minutes between each wash) - washing is critical! After your third PBS 

wash, use the 10 minute wait time to label glass slides with your name, the date, any 

transfected constructs, the antibodies used and any additional conditions (control, 

+cLTD, etc.);


17. Mount your coverslips onto your labelled slides using around 8µl or one drop of 

Molecular Probes ProLong Anti-fade mounting media, remembering to flip the 

coverslip as you do. All fluorescent signals fade with time as they are exposed to 

their excitation light wavelength and emit photons. This step reduces the amount of 

fade that occurs in this fluorescence signal from neurons on your coverslip and 

allows us to store them for up to two weeks. If using a pipette, take up 10µl of 

ProLong to avoid creating bubbles;


18. Place your slides in a flat slide box in the 4°c fridge overnight to dry. Make sure you 

label your slide box with some tape and your name so that it’s easier to locate later.


!
On the third and final day:  

!
19. Add clear nail varnish to the perimeter of your mounted coverslips to seal them. 

Once dry, they’re ready to be imaged! 


!

What is a confocal microscope? 
!
In the Bamji lab, we primarily use our confocal for fluorescence microscopy. It works by 

beaming a specific wavelength of light onto a given specimen, causing responsive 

elements (e.g. fluorescent molecules excited by that wavelength) in your specimen to 

reflect light. This reflected light is then focused by mirrors towards the camera. However, 

the majority of the camera is obstructed and only a pinhole-sized opening permits the 

entry of light. The only light capable of entering the camera must then have travelled a 

direct path known as the focal plane. Thus, only in-focus light reaches the camera and 

becomes reproduced in the final image by the imaging software (FluoView). Other types 

of microscope can be used for fluorescence microscopy. However, all microscopes 

produce a degree of light scatter, which creates fuzzy, out-of-focus regions in your 

images. The confocal microscope is a popular piece of equipment as it limits the amount 

of scatter, producing crisper images and it is from this quality that it derives its name. An 

additional benefit to confocals is that microscopy can be performed on live cells, as it 

uses light to image (not electrons) and it is unaffected by single-cell depths. 


!10
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Why might we use confocal microscopy? 
!
Confocal microscopy permits the imaging of fluorescence within your specimen. In 

untreated wild-type rodent neurons, fluorescent molecules are not endogenously 

expressed and thus imaging them on a confocal would result in blank images. However, 

when a fluorescent construct has been transfected or a fluorescent antibody used to 

immunostain, the presence of the associated protein will create a small area of light 

within the image. The relative amount of a fluorescent molecule present in a given space 

will create a range of intensities in the resulting image. The relative intensity is therefore 

a crude measure of protein concentration in that region when using fluorescent protein 

constructs or monoclonal antibodies. This phenomenon can be utilised for a range of 

purposes, including the visualisation, trafficking and colocalisation of proteins. For 

example, if GFP, PSD95-RFP and X-BFP constructs were transfected into our neurons, a 

myriad of data could be extracted from confocal images of these cells. The cell fill (in 

this case GFP) allows us to visualise the cell morphology and localise the rest of our 

proteins therein using a specific wavelength laser as the light source (which for GFP is 

488nm). The PSD95-RFP protein indicates postsynaptic regions in your transfected 

neuron excited instead by a different wavelength of light and thus a different laser. 

Similarly, the X-BFP protein is excited by another wavelength and thus three different 

images of the cell can be taken using different wavelengths of light, each displaying a 

single protein. These images can then be superimposed. In the case of our example, the 

X-BFP protein can be localised either within the dendrites, spines or cell body by 

overlaying the GFP cell fill. PSD95-RFP, however, can be used to test whether the X-BFP 

protein is localised specifically to post-synaptic regions or is recruited to post-synaptic 

regions under certain conditions.


!

How do I use the confocal microscope? 
!
This lab guide has been created as a reference for you. As with all of these techniques, 

you will be trained by a lab member on how to perform them, but when you’re new to 

the lab, we understand that it’s easy to become swamped by all this new information. 

However, the confocal microscope is an expensive piece of equipment that facilitates a 

lot of our research. It is therefore imperative that you have received one-on-one training 

on how to use the microscope before attempting it. Do not use these guidelines in lieu of 

in-person training! 


!
Important: On any given day, it is rare to find the microscope unoccupied. A calendar 

(accessible here — user: Bamjilab pass: synapse) exists for the microscope, which you 

can use to book yourself time. Do not assume that you will be able to get time for the 

following day. Instead, try to book at least a week in advance.


!
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http://ubcflow.ca/WebCal/login.php?
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1. To turn on the microscope, flip the switches for the HG power (1), microscope (2) 

and confocal PSU (3) in that order. You’ll also need to turn on the lasers you require. 

The 543nm and 633nm are operated by turning a key, while the 405nm and 488nm 

laser have both a power switch and then an emission key;


2. Load up the FluoView software (user: BamjiLab pass: synapse) on the microscopy 

room computer (user: Administrator pass: fluoview). If FluoView is already open 

when you enter the room, we recommended closing it and reloading it, as the 

software is prone to crashing. Make sure the epi-lamp filter is open;


3. If the microscope is properly turned on, an ‘Image Acquisition Control’ interface will 

open in FluoView upon loading. Click the dye list icon and select the dyes you 

are imaging (e.g. eGFP, Alexa Fluor 568, etc.);


4. Using the ‘Acquisition Setting’ interface, set the objective lens you require for your 

images by selecting it from the drop down list under Microscope;


5. Spray some glass cleaner onto a tissue and gently clean the top of your coverslip;


6. If you’re using an oil immersion objective (please check this with a lab member), add 

a drop of immersion oil to the lens, which lies beneath the stage;


7. Ensure that the lens is centrally positioned beneath the stage and then place the 

slide facedown on the microscope stage so that your coverslip is facing the lens;


8. Press the epi-lamp button  on the ‘Image Acquisition Control’ interface to begin 

beaming light onto your specimen. Use the keypad to select the relevant filter 

(wavelength stimulation) for your cell fill;


9. Look down the eyepiece and use the focus knob to adjust the field of view until a 

cell is clearly visible. It will likely be easiest to find a cell to focus on in the middle of 

your coverslip. Unlike traditional microscopes, our confocal uses a button to switch 

the focus knob between coarse and fine adjustments; 


10. On the ‘Image Acquisition Control’ interface, press the Focus x4 button. A live image 

of the neuron should appear on the screen. You will have to adjust the focus again. 

To the left hand side of this live image is a series of numbers referring to the order of 

your different channels and thus the images that are being superimposed. By 

clicking a number, you can remove the corresponding channel from the display;


11. This next step we recommend you perform on a control coverslip, though this may 

not be sensible for all experiments. Excluding your cell fill channel where the aim is 

to capture the cell morphology and not to perform quantitative analysis, you need to 

adjust the intensity levels of each of your channels. To do this, remove the other 

channels from the live image view and press Ctrl + H to switch to an intensity map 

view. Your intention is to prevent all of the red maxxed out intensity and to set the 

background of your image as the blue minimal intensity. In order to do this, use the 

HV and offset columns in the ‘Image Acquisition Control’ interface for each of your 

channels. As you adjust the settings in these columns, your live image will update. 

You want to bring the HV up to the point that red intensity just starts to appear by 

hovering over the column and scrolling up on the mouse. Once maxxed intensity 

first starts to appear, bring the HV down a little, so that no areas of red intensity are 

!12
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present. For the same channel, you need to bring offset down until no blue minimal 

intensity is present in your live image. Then, bring it up until blue patches first start 

to appear in your image. Repeat this step for all of your channels, excluding your cell 

fill. For the cell fill, the intensity can be adjusted to produce the clearest depiction of 

cell morphology, but the amount of red maxxed out intensity is irrelevant. The 

background, however, should contain some patches of blue minimal intensity; 


12. Now that you have set your intensity levels, you must not alter them. All of your 

images for an experiment must be taken at the same settings. If you are returning to 

the microscope to take more images, you can reload your settings by opening one 

of your previously taken .oif files for that experiment in Fluoview, pressing the 

button to open the control panel and then reloading the image settings using the 

button.


13. Begin imaging the coverslip from the upper leftmost portion and 

scan it using the path shown in the diagram to the right. When 

you encounter a cell you would like to image, readjust the focus 

on the software using the Focus x4 button and the focus knob. 

When you feel that you are ready to take the picture, use the  

button. The software will take a moment to take the 

image, but it will pop up once complete. If this is your first 

time imaging, create a folder with your name on the desktop of the microscope 

computer. Inside this folder, create a dated folder giving the date the coverslips were 

mounted on the glass slides. Inside, create a series of conditional folders (e.g. 

control, knockdown, rescue, etc.). If you are imaging coverslips from more than one 

experiment, you may want to add additional folders to distinguish between them. 

Open a condition folder (e.g. control) and create a folder that starts with the 

condition and ends with the number of the cell for that condition. For example, let’s 

say you are saving the third cell from your control condition, the folder should be 

called ‘Con_N003’. Inside this folder, you can save the image of your cell. Make sure 

you are saving the file as a .oif file type as this will give you both the original 

FluoView image and additional .tif files for each channel that you need to analyse 

later;


14. Once you have imaged a coverslip, remove your slide from the stage. Try to find at 

least 10 neurons per large coverslip. If you are using immersion oil, clean the 

coverslip with a tissue and the objective using a lens cleaning wipe. Label the 

imaged coverslip with an indelible dot and, if using it, replace the oil before moving 

on to image the next coverslip, starting again at step 13 of this protocol;


15. If the microscope will sit unused for several hours after you’ve finished, we 

recommend that you turn it off. Use the confocal calendar and consider asking 

fellow lab members before doing so. Start by closing the Fluoview software. Then, 

turn off your lasers. For those lasers with power switches (405nm and 488nm), turn 

off the emission key and allow them to sit for 10 minutes before returning to switch it 
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off. Finally, turn off the confocal PSU (3), microscope (2) and HG power (1) in that 

order.


!

How do I analyse my confocal images? 
!
There are four major elements to analysing the images you obtain from the confocal: 

Photoshop, ImageJ, Excel and GraphPad Prism. Not all of these steps will be relevant or 

correct for any given experiment, but the common sequence of events shall be outlined 

in this lab guide. Instructional videos of these steps are available from the desktop of the 

lab computers in the ‘Tutorials’ folder.


!
Photoshop 


!
Open the associated .tif image files for a cell in Photoshop. On the cell fill image, press 

Cmd + L () or Ctrl + L (   ) to bring up the levels command and change the last 255 

value to around 15. Press ‘OK’. Next, select the paint brush tool, make the active 

colour absolute black (#000000) and alter the paint brush size as necessary. Begin to 

mask the cell fill by blacking out parts of the image that are out of focus or broken and 

cellular parts you are not sure belong to your cell, e.g. they enter the image from off-

screen or seem to stem from an adjacent cell. Lastly, you want to remove the cell body 

or soma, leaving you with the dendrites and the axon. If you have lower magnification 

images than x60, the axon can also be removed if need be. Once complete, use the 

magic wand tool to select the black background ensuring that the tolerance is set to 

20 and contiguous is unticked. Create a new layer  and then use the paint bucket 

tool  to fill the selection in with black. The image visually shouldn’t change, but you 

should notice in the layers section that you now have one image of your cell and one 

layer containing just the black regions. Make sure that your newly created layer is active, 

select all and then copy and paste this layer onto the other .tif images for that cell. In 

doing so, you have excluded any fluorescent signal (and thus protein) that does not arise 

from your cell of interest. Merge these two layers together by pressing Cmd + E () or 

Ctrl + E (   ). Convert every image to 8-bit by going to Image > Mode > 8-bit, then you 

are ready to save. In the folder containing your conditions, create a new folder called 

‘Masks’. Then reproduce the folder layout for the conditions and cell number, e.g. 

Control > Con_N003. Save all three of your masked .tif images for the cell into the cell 

name folder, being sure to create a new one for each cell in that condition.


!
ImageJ and Excel 

!
ImageJ is an open access image processing software developed by the National 

Institutes of Health. You can download the basic program free of cost here. A number of 
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plugins exist to adapt the software for more specific purposes. One we frequently use in 

our lab is NeuronJ, which you can download here.


!
Setting the scale 

Whenever you reopen ImageJ, you need to set the scale for your images. We most 

frequently work in µm, while the default settings are typically either pixels or cm. In order 

to change these settings, open one of your unedited .tif images for that experiment in 

ImageJ. Go to Analyze > Set Scale… You’ll notice that the default ‘unit of length’ is cm. 

Change this to um and then move the decimal point in the ‘distance in pixels’ up four 

numbers (as 1cm = 10,000µm). Make sure you tick ‘Global’ to maintain this setting for all 

of the images you open until ImageJ is closed, then hit OK and close the unedited 

image.


!
Tracing your neuron 

As the cells you are comparing will differ in size, you cannot directly compare the 

number of proteins present in your images. One way to account for these size difference 

is to take a measure of cellular length and divide the amount of protein by the length. 

Equally, you may wish to look at changes in neuronal length under various conditions. In 

order to perform these analyses, you must trace your neuron using the NeuronJ plugin. 

In ImageJ, go to Plugins > NeuronJ. You should notice that the ImageJ interface 

changes. Load your masked cell fill image in NeuronJ using the load button a n d 

then click the add tracing button to start measuring length. You’ll notice that your 

cursor forms a + sign. Left click on a dendrite to start tracing it and use the mouse to 

follow its length. The program will try to predict the trajectory of the dendrite, but if you 

find it is making incorrect predictions, you can left click again to set a fixed point along 

the trajectory. When you’ve finished tracing a single dendrite, left click and then press 

the spacebar. The program should stop tracking the movement of your mouse and the 

tracing should end at the last fixed point you set at the end of your dendrite. Simply left 

click again in another area of the image to start another tracing. If you ever make a 

mistake in a tracing, end the tracing and select the remove tracing button . Click the 

tracing you’d like to delete and press ‘Yes’. Once you’ve traced the entirety of your 

neuron, you can now measure the length using the measure tracings button, which 

will create a popup. Typically, you will not need the tracing or vertex measurements. 

Click ‘Run’ and ImageJ will present you with the data for your cell. Copy and paste this 

data into a number processor (e.g. Excel) sheet titled ‘Tracings’ using the below format:
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Once you’ve copied the data into your number processor, save your tracings into the 

same folder as your masked .tif images for that cell and close the image. You can now 

repeat this process with the rest of your cells.


!
Running a macro 

A macroinstruction or macro is a piece of coding that defines a number of software 

functions. When you run a macro, the coding therefore instructs the software on the 

steps it should perform. It allows us to standardise analysis and to code conserved 

sequences of image processing, rather than manually performing it over and over for 

every cell. As such, there is no standard protocol that applies to all macros, so instead I 

shall take you through a commonly used macro in the Bamji lab — the colocalisation 

macro. This macro takes two confocal images and quantifies the amount of light 

patches or puncta present in each of the images. It also tells you how many of those 

puncta would overlap if you were to superimpose the images. As you can imagine, if 

your first image is an immunostain for a ubiquitously present synaptic protein and the 

second image is an immunostain for your protein of interest, when any points overlap, 

you can assume that puncta of labelled protein is present at a synapse. To run this 

macro, two of your non-cell fill layers must be open in ImageJ. A threshold must be set 

for each of these images. To do so, click on one of your images and go to Image > 

Adjust > Threshold. A popup with two sliding bars should appear. Move the bottom bar 

all the way to the right and you should notice that your image turns entirely red. Slowly 

move the top bar to the right and you will start noticing that red spots of reducing size 

appear in your image. You want to adjust this top bar until all the light spots in your 

image and as little of the background as possible are captured by the red. When you are 

comfortable you have set the appropriate threshold, take note of the number of the top 

bar. Repeat this step for the other channel. You may want to do this for several cells 

(~10), keeping note of the channel you are thresholding. You can then produce an 

average threshold for each of the channels and use it to edit the threshold settings in the 

macro code, which you must not alter between cells. When you have added the 

threshold average to your macro for both channels, save it and close any images open 

in ImageJ. 


!
Now, open two non-cell fill images of a cell you wish to analyse and go to Plugins > 

Macro > Run…, which you should use to find the macro file. The program will then begin 

performing the encoded functions. At the end, only two screens should be open on 

ImageJ: One providing you with data output and the other depicting a colour coded 

superimposed image of the puncta detected by the software at your set threshold. Copy 

and paste the data output into the same number processor file as your tracings, though 

preferably into a new sheet labelled ‘Colocalisation’. Use the format displayed below. 


!
!
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Close any open windows and then repeat the steps described in the second paragraph 

of this section for all of the cells you wish to analyse. Once you have all of the data in 

your number processor, you can use it to calculate any descriptive values you might 

need (e.g. number of PSD95-RFP puncta/length in µm) in additional sheets. For 

example, you may need to calculate the density of the PSD95-RFP puncta, so a sheet 

named ‘PSD95-RFP density’ can be produced. In which, every cell separated by 

condition would have its PSD95-RFP puncta count divided by total cell length. Then, the 

mean and standard error of the mean (SEM) of these values can be calculated and 

graphed (bars representing the mean and error bars representing the SEM) to give you 

an overall representation of your data.


!
Obtaining statistical significance with GraphPad Prism 

In science it is not enough to simply graph data. Our data must be analysed using 

statistics to discern the level of mathematical confidence we have that the null 

hypothesis for our experiment can indeed be rejected. The specific statistical test you 

need to run will differ from experiment to experiment, depending on the type/quantity of 

data you’ve collected and whether you’re looking for a difference or a relationship. Make 

sure you speak to fellow lab members if you are unsure which test you need to run for 

your data. The majority of our cellular experiments look for differences between the 

means of three or more conditions and thus the appropriate stats test is an analysis of 

variance (ANOVA). This guide shall therefore take you through how to use GraphPad 

Prism to perform an ANOVA with a Tukey post-hoc test. A post-hoc test is necessary as 

an ANOVA will only tell you if at least one of your means significantly differs from at least 

one other mean. However, an ANOVA alone will not tell you where this significance lies 

(e.g. between control and knockdown, but not between control and rescue), which the 

post-hoc test will. 


!
In the Bamji lab student office (Room 2.453), load GraphPad Prism on Zeus. A ‘Welcome 

to GraphPad Prism’ interface will appear. Click Column under the New table & graph 

section, then select the vertical column bar graph. Under plot, select the Mean with SEM 

and click Create. Separate your conditions on the resulting spreadsheet by naming each 

column. Consider the row number to be the cell number for each condition. Copy each 

data point (e.g. for PSD95-RFP density/µm) from your number processor into the 

corresponding cell on Prism. Next, click the Analyze button under analysis. On the 

resulting popup, select ‘One-way ANOVA (and nonparametric)’ under Column analyses 
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and click OK. Another popup shall appear for the 

ANOVA. As previously stated, many of these 

options may be pertinent to your specific analysis, 

but for the purpose of this booklet we shall not be 

using the vast majority of them. Click the Post test 

drop down list and select ‘Tukey: Compare all pairs 

of columns’. Click OK. The program shall then give 

you an output for both the ANOVA and the Tukey 

post-hoc test, detailing where any statistical 

significance lies. On the sidebar to the left, 

different steps in your GraphPad Prism analysis can be seen, including Data Tables for 

the raw data, Results for the output of statistics and Graphs for the graphical 

representation of your data. You will need to combine the info from the Results section 

with the graph to indicate which bars of the graph significantly differ from each other. 

Once you’ve edited the graph and titled your axes, the graph can be copied, e.g. into 

Powerpoint, Word or Photoshop. The figure to the right gives an idea of the expected 

format of any graphs you produce.


!
!
!
!
!
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!
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